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MOVE2019.1.0 SOFTWARE AND SUPPORTING DOCUMENTATION

Move2019.1.0 Software

Move2019.1.0 Software Installers for Move and Knowledge Base

Move2019.1.0/Windows64 Installers for Windows (64-bit)

License Manager Software

Petroleum Experts License Manager Software including documentation available as a separate download

Beginning with MOVE 2019, MOVE is licensed solely using the Petroleum Experts HARDLOCK License
Manager.The FlexNet Activation licensing method has been removed from the software and licensing
system. In summary:

l Support for FlexNet licensing manager has been removed from the software and licensing system.
l MOVE 2019 requires a HARDLOCK license and will not work with previous FlexNet License Manager 
installations.

l The MOVE 2019 installer installs a Windows Service (Petroleum Expert Licensing) that allows MOVE to 
communicate with the HARDLOCK License Manager, or a BITLOCK Licensing Dongle.

l Following the installation of MOVE 2019, the Setup HASP Bitlock Driver program needs to be run 
from the Petroleum Experts Licensing folder of the Windows Start menu. This installs the device 
driver for the BITLOCK Licensing dongle.

Move Link for Petrel Software Installers

MoveLinkforPetrel/Petrel 2017 MSI and PIP Installers for Petrel 2017

MoveLinkforPetrel/Petrel 2018 MSI and PIP Installers for Petrel 2018

MoveLinkforPetrel/Petrel 2019 MSI and PIP Installers for Petrel 2019

Move2019.1.0 Release Documentation

The following documents, Tutorials, and Knowledge Base are provided with Move2019.1.0

The Knowledge Base resource contains all the Move Help Pages, Tutorials, Monthly Features and release
documentation presented in a single, offline, searchable entity, independent of Move.

The Knowledge application is now installed alongside MOVE via the installer.

l Move2019.1.0 Release Notes PDF
l Move2019.1.0 Installation Guide PDF
l Move2019.1.0 Tutorials
l Move2019.1.0 Tutorial Data Files
l Open Server User Guide PDF

2019.1.0 Installation Guide
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SYSTEM REQUIREMENTS

Operating Systems

Please check to ensure you have at least the minimum specification before installing:

Windows
(native)

Windows 64-bit OS releases only; latest tested and supported version -
Windows 10.0.18362 1903 (May 2019 Update).
Compatible with 64-bit versions of Windows 7 SP1, Windows 8, and
Windows 8.1.
MOVE is not supported on Windows XP, or Windows Vista.

Windows requires .NET Framework 4.6. or higher.

Cloud
(VM)

Microsoft Azure - for Move to function effectively it requires an Azure N-
Series VDI optimised specification for or similar eg NCv3-series (Tesla
V100 GPU), ND-series (Tesla P40 GPU)
https://docs.microsoft.com/en-us/azure/virtual-
machines/windows/sizes-gpu

Amazon EC2 - for Move to function effectively it requires an EC2 P3 VDI
optimised specification for or similar eg p3.2xlarge (1 Tesla V100 GPU) ,
p3.8xlarge (4 Tesla V100 GPUs)
https://aws.amazon.com/ec2/instance-types/p3/

Google Cloud - for Move to function effectively setup your Compute
Engine instance to add GPUs eg NVIDIA Tesla P100 Virtual Workstations:
nvidia-tesla-p100-vws
https://cloud.google.com/compute/docs/gpus/#gpu-virtual-
workstations

Schlumberger DELFI - MOVE is now provisionally supported in the DELFI
COGNITIVE E&P ENVIRONMENT
https://www.software.slb.com/delfi

Graphics Card

Move is a graphics intensive application and takes advantage ofmodern hardware GPUs in order to speed up
3D rendering. The more memory on the graphics card the better Move will handle larger 3D/2D Seismic files,
DEMs and Image overlays.

Graphics Card minimum requirements (Notebook or Workstation)

l Minimumof 4GB of RAM, Graphics card drivers fully up to date, Pixel Shader 2.0 or later, OpenGL
compatible

Notebook Graphics Card mid-range:

l NVIDIA with 4-6 GB RAM e.g. Quadro M4000M, M22000, P2000, P3000, P3200

2019.1.0 Installation Guide
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Notebook Graphics Card high-end

l NVIDIA with 8-16 GB RAM e.g. Quadro P/M5000, P/M6000,M5500, P4000, P5000, P4200, P5200

Workstation Graphics Card mid-range

l NVIDIA with 4-8 GB RAM eg. Quadro M2000, M4000, M5000, P1000, P2000, P4000

Workstation Graphics Card high-end

l NVIDIA with 12-32 GB RAM e.g. Quadro K6000, M6000, P5000, P6000, GP100, GV100

Hardware

The following list is provided as a general guide only. If your system configuration is different and you are
unsure of its capability then please email us: edinburgh@petex.comwith your system details for further
information. The hardware requirements greatly depend on the size of data sets you are using. If you are
working with large data sets and utilising Move applications simultaneously then we would strongly suggest
the following recommendations.

Workstation/Desktop

For example, Dell Precision 5820, 7820, 7920

Specification Recommended Minimum Recommended Ideal

CPU
Intel i5 quad-core  Intel i7 /Xeon E5

4C/6C/8C/12C

Memory 8 GB 16-128 GB+

Laptop/Notebook

For example Dell Precision 5 5530 15", 7530 15”, 7730 17”

Specification Recommended Minimum Recommended Ideal

CPU Intel i5 4C Intel i7/i9 4C/6C

Memory 8 GB 8-64 GB+

Screen/Monitor

l Minimum screen resolution is a single monitor/screen with 1920 x 1080 pixels (full HD 1080p)
l Move is a graphics intensive application supporting multiple simultaneous views of your data model,
and we recommend as much screen space as you can afford in order to maximise your experience and
attention to detail.

l Move will support dualmonitors which are recommended at 30” in size and above.

2019.1.0 Installation Guide
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INSTALLING MOVE

Installing on Windows

It is recommend that you should be a Windows Power user/ Administrator or have UAC (user access control)
elevated to administrator to install on Windows.

Move2019.1.0 requires .NET Framework 4.6.

l Desktop - .NET Framework 4.6 comes pre-installed with Windows 10 first version and all versions
thereafter. Can be downloaded forWindows 8.1, 8 and 7.

l Server - .NET Framework 4.6 comes pre-installed with Windows Server 2016 and all versions
thereafter. Can be downloaded forWindows Server 2012 R2, 2012, 2008 R2 SP1, 2008 SP2.

To begin the installation process youmust browse to the installer file, for example:

:\Move2019.1.0\Windows64\move_2019.1.0_windows_64-bit.exe

Installation Folder

Select the folder in which you wish to install Move. Youmay select your own location by clicking Choose or by
typing the explicit location in the input box. By default it is:

C:\Program Files\Petroleum Experts\Move2019.1.0

2019.1.0 Installation Guide
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Uninstalling Move on Windows

Please use the Control Panel to uninstall Move.

Using Windows Remote Desktop

When connecting to a remote system using Microsoft’s Remote Desktop Services youmay experience
issues when using largermodels. This is due to limitations with the software OpenGL driver that is used when
using the remote connection. There are several ways to work around such issues:

Use another remote display application that uses the hardware capabilities of the host machine.

Start Move on the host machine BEFORE connecting to it. This requires physical access to the host system.

Use the alternate software OpenGL drivers provided with Move. These are located in the bin/mesa3d folder
inside the location where Move was installed. When Move senses that it is running remotely then it will
prompt the user that the software drivers are being copied into the bin folder and being utilised. See notes
below:

Cloud and Virtual machine usage additional notes:

Clients can use Move via remote or cloud solutions or technologies e.g. HP RGS, VMware vSphere, Citrix
Xen, Microsoft Azure, OpenText Exceed, orWindows Server 2016 DDA/Remote FX.

Youmust ensure for the best experience that the remote machine or technology has dedicated or a virtual
GPU resource that will enable 3D graphics, OpenGL, and GPU capability. The Azure Cloud (N-Series), or
Windows Server 2016 DDA/Remote FX capability both provide GPU solutions.

You can run Move on the Windows Server environment using basic RDS/RDP technology, however Move will
fall-back to “software” rendering for OpenGL or GPU code. This is satisfactory to a degree, however will be
much slower that “native” ormanaged “virtual/cloud” solutions, with 2D or 3D Seismic rendering being
especially very limited.

The number of choices for deployment to the cloud or a virtual environment is really client preference, and
we cannot recommend one solution over another. We also cannot test Move in all end-user virtual
environments due to sheer number of possible software and hardware configurations, however we can
assist with any problems youmay come across when the environment or solution is being tested prior to
production.

3D PDF Animations

Onmachines without Adobe Flash Player installed, the 2D animation controls in the 3D PDF output fail to
function. Flash is NOT required for viewing the 3D content files, only the 2D Section Animations. Install Flash
Player software to resolve this issue.

The Acrobat Player errormessage links to here:

https://helpx.adobe.com/acrobat/using/flash-player-needed-acrobat-reader.html

2019.1.0 Installation Guide
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MOVE LINK FOR PETREL V2019.1.0

The Move Link for Petrel* provides a means for Petrel users to share and transfer data with Petreoleum
Experts Move product.

Once installed, the Link allows the Petrel user to specify objects within the input tree to send across to Move.
Once in Move, it is then possible to performmodel building, editing and analysis or utilise functionality within
the modelling modules to perform restoration, validation, balancing, Fault Analysis, Stress Analysis,
Geomechanical Modelling, Fracture Modelling and Fault Response Modelling on the transferred objects (if
licenses for these modules have been purchased and are available).

*Mark of Schlumberger

System Requirements

Software

To use the Move Link for Petrel (version 2019.1.0), users are required to have a valid licence of:

l Petroleum Experts Move application 2019.1.0 (Move2019.1.0)
l Schlumberger’s Petrel seismic to simulation software version 2018.x, 2017.x, or 2016.x
l Move Link for Petrel version 2019.1.0 from Petroleum Experts. For clarification on compatibility please
emailedinburgh@petex.com.

Operating System

Petrel is a Windows only product and therefore the Move Link for Petrel will only be available where all
products are running onWindows. See the Move system requirements and the Petrel software system
requirements for details.

Installation

Move Link for Petrel can be either be installed using the Ocean Plugin Manager, or directly using the provided
msi installer package files.

To install using the Plugin manager.

l Access the Ocean Plugin Manager... (when using the ribbon interface this is accessed via the File ->
Options menu, and in the Classic User interface via the Help menu)

l Select Install plugin.
l Browse to the appropriate pip fie on the installation disk( see table below ).
l Close down Petrel.
l When Petrel is restarted, the Move Link icon will be visible (If using the ribbon interface, this will be in a
newMVE group in the Home tab, and when using the classic interface, as a tool button in the File
Actions toolbar.

It is recommended that the plugin is installed using administrator privileges.

Move Version Petrel Version Move Link for Petrel Version (via pip or msi)

Move2019.1.0 (64-bit) 2019.x (64-bit) MoveLink2018forPetrel2019.pip

Move2019.1.0 (64-bit) 2018.x (64-bit) MoveLink2018forPetrel2018.pip

Move2019.1.0 (64-bit) 2017.x (64-bit) MoveLink2018forPetrel2017.pip
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MOVE LINK FOR OPENWORKS R5000

The Move Link for OpenWorks R5000 provides a means for LandmarkOpenWorks users to share and transfer
data with Petroleum Experts Move Application of the Move Suite.

The Link allows the Move user to directly import objects within an OpenWorks R5000 database via the input
tree to send them across to Move. Once in Move, it is then possible to performmodel building, editing and
analysis or utilise functionality within the modelling modules to perform restoration, validation, balancing,
Geomechanical Modelling, Fracture Modelling and Sediment Modelling on the transferred objects (if licenses
for these modules have been purchased and are available).

Software

To use the Move Link for OpenWorks R5000, users are required to have a licence of:

l Move Link for OpenWorks R5000 software from Petroleum Experts.
l Move software from version Move2019.1.0 from Petroleum Experts.
l Windows - LandmarkOpenWorks software from version 5000.10.5 back.
l Oracle software version 11g onwards.

For clarification on compatibility please email: edinburgh@petex.com.

Operating System

Please check to ensure you have at least the minimum specification before installing:

Windows Microsoft WindowsWindows 7 (64-bit).

Installation (client)

The Linkwill workwhether running Move from the same machine as OpenWorks is installed on or
alternatively from a client machine on the network that can see the OpenWorks and Oracle installations.

LinuxMove clients should ensure that Oracle and OpenWorks installations are on your PATH and LD_
LIBRARY_PATH and visible on the network. Optionally on Linux you can install a local client of Oracle
software.

Windows clients MUST install Oracle client and OpenWorks client software before you run Move. See the
installation guides from these products formore information. Petroleum Experts do not supply Oracle or
LandmarkOpenWorks clients; these can be obtained as part of your own OpenWorks installation - contact
your own local OpenWorks administrator. Some environment variables that need to be set or will help set-up
include:

l OWHOME, OW_ORACLE_USER OW_HOME_DIR

2019.1.0 Installation Guide
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CONTACTING PETROLEUM EXPERTS

Contact Details

Edinburgh Office
Petroleum Experts Ltd.
Petex House, 10 Logie Mill
Edinburgh, EH7 4HG, UK
www.petex.com/products/move-suite/

T: +44 (0) 131 474 7030
F: +44 (0) 131 474 7031
Email : edinburgh@petex.com

Houston Office
Petroleum Experts Inc. US
757 North Eldridge Parkway, Suite 510
Houston, Texas
77079
USA

T: +1 281 531 1121
F: +1 281 531 0810
Email : houston@petex.com
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